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Design Master Electrical RT Tutorial
You are reading the tutorial for Design Master Electrical RT 1.4.

These tutorials teach you the basics of using the software. The Where to Learn More section at the end of the
tutorial points you to the other resources we have available.

The tutorials are sequential and build on each other. It is simplest to follow them from start to finish.

Tutorial Resources

Download the tutorial files from our website.

The files contained in this ZIP file are used in the tutorial. The ZIP file also contains a PDF copy of the tutorial.
Extract the ZIP file to a folder where you can easily find it again.

You can also watch the video tutorial for Design Master Electrical RT 1.3, which follows much of the material in
these tutorials.

Getting Help

Contact us if you need any help while working through the tutorials.

Our support hours are Monday through Friday, 9am to 5pm Eastern time.

Call 866-516-9497 x2, email support@designmaster.biz, or contact us via live chat.

http://files.designmaster.biz/dm-dmert-tutorial.zip
http://www.designmaster.biz/support/blog/2019/05/design-master-electrical-rt-video-tutorial-series
mailto:support@designmaster.biz
http://www.designmaster.biz/chat/
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Making Changes: Don't Modify the
Shared Parameters

While using Design Master Electrical RT, you should make changes to the model using the Panel Edit,
Circuit Edit, and Instance Edit commands.

Do not make changes to the shared parameters that are used by the software, either through the Properties
window, Schedules, or Panel Schedules. Those values are used only for output purposes. They are not used for
input. Design Master Electrical RT will overwrite any changes you make to those values the next time an update
happens.

The built-in circuit Rating value for electrical systems is also controlled by Design Master Electrical RT.
Previously, to change a breaker size, you would set it in the panel schedule. That will no longer work. Instead,
you need to change the value that controls the breaker size using Design Master Electrical RT commands.

The built-in circuit description value for electrical systems can also be controlled by Design Master Electrical RT.
The Modifying Branch Circuit Devices section describes how to enable this feature and how to change the
description using Design Master commands.
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Starting a New Project
This section teaches you how to start and configure a project for use with Design Master Electrical RT.

Start the Project in AutoCAD

1. Start AutoCAD.

2. Open drawing E-0.1.

3. Run the Start New Electrical RT Project command. The Start New Electrical RT Project dialog box
will open.

Ribbon: DM Electrical RT->Utilities->  Start New Electrical Project

Pulldown Menu: DM Electrical RT->Start New Electrical Project

4. Press the OK button to close the dialog box.

The project database will be created and initialized. This process takes a moment.

The project database is named dm_elec.dm. If you specify a Project Name, that is appended to the end of the file
name. There can be only one project database in a folder. All of the drawing files in the folder share the same
database.

Set Up the Sample Systems Project in Revit

The following steps configure the Sample Systems Project for these tutorials. Your projects will not require any
additional work to set up.

1. Start Revit.

2. Go to File->Open->Sample Files and open project rme_basic_sample_project.rvt.

3. Go to File->Save As->Project and save the project in the same folder as drawing E-0.1.
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Modifying Distribution Equipment
This section teaches you how to work with distribution equipment.

Design Master Electrical RT refers to all equipment that provide power to other equipment or devices as
"distribution equipment." Distribution equipment includes all of the equipment that have their Part Type set to
Panelboard, Other Panel, Transformer, or Switchboard. These tutorials cover panels, switchboards, and
transformers, but the concepts work the same for other types of distribution equipment.

Modify Distribution Equipment

1. Select transformer T-SVC and run the Panel Edit command. The Panel Edit dialog box will open with T-SVC
active.

DM Electrical->  Panel Edit

2. Make the following changes to T-SVC:

a. Set Transformer kVA to 600.

b. In the Fault Calculations section, set Utility Fault at Device to Fixed and enter 65000 for the value.
The fault must be set for the topmost distribution equipment in your model; if not, an infinite fault
from the utility is assumed.

3. Select SWB from the list and make the following changes:

a. Set Mains / Bus Amps to 400.

b. Set Main Disconnect Type to Breaker.

c. In the Upstream Connection section, set OCP Frame to 500.

4. Select MDP-3 from the list and make the following changes:

a. Set Mains / Bus Amps to 200.

b. Set Main Disconnect Type to Breaker.

5. Press the Exit button to close the dialog box.
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Modifying a Distribution Equipment
Family

This section teaches you how to work with distribution equipment families.

Modify the Family for T-SVC

1. Select transformer T-SVC and run the Revit Edit Family command. The family file will open.

Modify | Electrical Equipment->  Edit Family

2. Run the Family Edit command. The Family Edit dialog box will open.

DM Electrical->  Family Edit

3. Make the following changes to the family:

a. In the Family Settings section, set Device Type to Distribution equipment: Transformer.

b. In the 300 kVA section, set Override Family Values to Yes.

c. Set Transformer kVA to 300.

d. In the 500 kVA section, set Override Family Values to Yes.

e. Set Transformer kVA to 500.

4. Press the OK button to close the dialog box.

5. Update the family in the project using the Revit Load into Project command or Load into Project
and Close command.
You do not need to save the family file, but the parameters will only be used for this project if you do not save.

Create / DM Electrical->  Load into Project /  Load into Project and Close

Modify T-SVC

1. Select T-SVC and, in its properties, set Type to 300 kVA.

2. Run the Panel Edit command. The Panel Edit dialog box will open with T-SVC active.

DM Electrical->  Panel Edit

The Transformer kVA value has been updated to reflect the changes made to the family.

3. Press the Exit button to close the dialog box.
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4. Set the Type to 500 kVA and run the Panel Edit command again to see how the Transformer kVA
changes.

DM Electrical->  Panel Edit
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Modifying Branch Circuit Devices
This section teaches you how to work with branch circuit devices.

Design Master Electrical RT refers to mechanical equipment, receptacles, and other devices that connect to
distribution equipment as "branch circuit devices." Branch circuit devices include all of the electrical fixtures or
electrical equipment with their Part Type set to Equipment Switch.

Enable Circuit Descriptions with Design Master

With Design Master Electrical RT, circuit descriptions can be changed in a number of different places to give you
greater control over the values displayed in the panel schedule. By default, this functionality is bypassed so you
can continue to set circuit descriptions through typical Revit methods if you prefer.

To control your circuit descriptions using Design Master Electrical RT:

1. Run the Options command. The Options dialog box will open.

DM Electrical->  Customization->Options

2. Set Circuit description method to Use Design Master circuit descriptions.

3. Press the OK button to close the dialog box.

Modify the Cooling Tower with Circuit Edit

1. Run the Revit Default 3D View command.

View->  Default 3D View

2. Select the cooling tower and run the Circuit Edit command. The Circuit Edit dialog box will open,
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displaying the circuit to which the cooling tower is connected.

DM Electrical->  Circuit Edit

3. Make the following changes to the circuit:

a. Erase the Description Replacement value.

b. Set Breaker Trip Size to Size automatically.

c. Set Breaker Frame Size to Same as trip.

4. Press the Exit button to close the dialog box.

When using Design Master Electrical RT on existing projects, these fields are populated based upon the
parameters for the device. Values for new devices inserted on the model are shown in the Modifying a
Branch Circuit Family section.

Modify the Cooling Tower with Instance Edit

1. Select the cooling tower and run the Instance Edit command. The Instance Edit dialog box will open.

DM Electrical->  Instance Edit

2. Make the following changes to the cooling tower:

a. Set Override Circuit Description to Yes and enter C Tower for the value.

b. Set Breaker Size to 100.

c. Set Wire Size to Size based upon breaker.

3. Press the OK button to close the dialog box.

4. Select the cooling tower and run the Circuit Edit command to see how the values change.

DM Electrical->  Circuit Edit

Modify the Cooling Tower with Panel Schedules

As pointed out in the Making Changes: Don't Modify the Shared Parameters section, you should not use
schedules to modify devices while using Design Master Electrical RT. Changes made to schedules will be
overwritten by Design Master. Follow the steps below to see an example of this:

1. Open the panel schedule for CTP and make the following changes to the cooling tower circuit:

a. Set Circuit Description to Cooling Tower.
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b. Set Trip to 70 A.

2. In the 3D view, select the cooling tower and run the Circuit Edit command. The Circuit Edit dialog box will
open.

DM Electrical->  Circuit Edit

The circuit description and breaker size will still show their previous values. If you go back to the panel
schedule, the circuit description and breaker size will have reverted to their previous values.
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Modifying a Branch Circuit Family
This section teaches you how to work with branch circuit device families.

Open family Rooftop AC Units - Electric - 7.5 Tons.

Modify the Family for the ACU

1. Run the Family Edit command. The Family Edit dialog box will open.

DM Electrical->  Family Edit

2. Make the following changes to the family:

a. In the Family Settings section, set Device Type to Branch circuit device: Equipment connection.

b. Set Show on One-Line Diagram to Yes.

c. Set MOCP to 40.

d. Set Breaker Size to Motor-compressor, <= MOCP.

e. Set Wire Size to Size based upon loads.

3. Press the OK button to close the dialog box.

4. Save and close the family.

Insert the ACU on the Model

1. Run the Revit Mechanical Equipment command.

Systems->  Mechanical Equipment

2. Run the Revit Load Family command. The Load Family dialog box will open.

Modify | Place Mechanical Equipment->  Load Family

3. Load family Rooftop AC Units - Electric - 7.5 Tons.

4. Insert the ACU on the 3D view of the model the same way you normally would. The location does not
matter.

5. Circuit the ACU to panel CTP the same way you normally would.

Modify the ACU with Instance Edit



11

1. Select the ACU and run the Instance Edit command. The Instance Edit dialog box will open.

DM Electrical->  Instance Edit

2. Make the following changes to the ACU:

a. Set Override Circuit Description to Yes and enter ACU for the value.

b. Set Breaker Size to 70.

3. Press the OK button to close the dialog box.

4. Select the ACU and run the Circuit Edit command to see how the values set in the family are overridden by
the values set in the instance.

DM Electrical->  Circuit Edit
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Modifying a Branch Circuit
This section teaches you how to work with branch circuits.

Modify Circuits with Circuit Edit

1. Select panel PP-1A and run the Circuit Edit command. The Circuit Edit dialog box will open with PP-1A
active.

DM Electrical->  Circuit Edit

2. Select circuit 1 using the middle grid and make the following changes:

a. In the Circuit Details section, erase the Description Replacement value.

b. Set Breaker Trip Size to 30.

c. In the middle grid, select the Description and add "Existing " to the value. In the Circuit Details
section, the Description and Description Prefix values will update to reflect the change.
You can also use the Description Prefix field to make this change.

3. Select circuit 7 using the middle grid and make the following changes:

a. In the middle grid, set Description to REC. In the Circuit Details section, the Description and
Description Replacement values will update to reflect the change.
You can also use the Description Replacement field to make this change.

b. In the Circuit Details section, set Circuit Length to Fixed and enter 80 for the value. The Voltage
Drop value will update to exceed 3%.

c. Set Conductor Amps to 30 --- #10. The Voltage Drop value will update to a lower value.

4. Press the Exit button to close the dialog box.
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Creating Calculation Schedules
This section teaches you how to perform calculations on your electrical system and create fault and voltage drop
schedules.

Calculate the Project

Run the Calculate Whole Project command.

DM Electrical->  Calculate Whole Project

This will perform fault, voltage drop, wire sizing, and other calculations on your entire electrical model. This
process takes a moment.

Create and Modify the Fault Schedule

1. Run the Fault Schedule command. The Fault Current Schedule will open.

DM Electrical->  Schedules->Fault

2. Run the Revit Modify Schedule->Insert command. The Select Fields dialog box will open.

3. Make the following changes to the fault schedule:

a. Remove the Short Circuit Rating field from the Scheduled fields list.

b. Add the DMET_Panel_BusAmps and DMET_Panel_Distribution_System fields to the Scheduled fields
list.
Design Master shared parameters always begin with DMEN for number types or DMET for text types.

4. Press the OK button to close the dialog box.

The fault schedule will be updated. You can make further changes to the schedule title, field headings, and
column order the same way as any other schedule in Revit.

Create and Update the Voltage Drop Schedule

1. Run the Voltage Drop Schedule command. The Voltage Drop Schedule will open.

DM Electrical->  Schedules->Voltage Drop

The voltage drop at some devices is probably very high. That is partly because the voltage drop through
transformers is being included by default. This setting can be changed depending upon how you want to
calculate voltage drop through a transformer.

2. Run the Options command. The Options dialog box will open.

DM Electrical->  Customization->Options
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3. Set Transformer voltage drop calculation method to Ignore transformers.

4. Press the OK button to close the dialog box.

5. Run the Calculate Whole Project command.

DM Electrical->  Calculate Whole Project

The voltage drop schedule will update to show the new values.

Calculate Part of the Project

1. Run the Panel Edit command. The Panel Edit dialog box will open.

DM Electrical->  Panel Edit

2. Select panel LP-3B and set Main / Bus Amps to 60.

3. Select panel MP-3B and set Main / Bus Amps to 60.

4. Select transformer TP-3A and set Transformer kVA to 150.

5. Press the Exit button to close the dialog box.

6. Run the Fault Schedule command. The Fault Current Schedule will open.
This is optional, but will make it easier to see the changes.

DM Electrical->  Schedules->Fault

7. Run the Calculate Part of Project command. The Calculate Part of Project dialog box will open.

DM Electrical->  Calculate Part of Project

8. Select panel MDP-3 and press the Calculate button.

Calculations will be performed only on this panel and downstream devices. When the calculation finishes, the
fault schedule will update to show the new values.
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Customizing Wire Ampacities
This section teaches you how to customize your wire ampacities and use your customization in future projects.

Modify the Wire Ampacities

1. Run the Wire Ampacities command. The Wire Ampacities dialog box will open.

DM Electrical->  Customization->Wire Ampacities

2. Make the following changes to the 400 ampacity row:

a. Set Wire Size to 3/0.

b. Set Ground Wire Size: Service to #4.

c. Set Ground Wire Size: Equipment to #6.

d. Set Parallel Runs to 2.

e. Set X to 0.042.

f. Set R to 0.077.

3. Press the Exit button to close the dialog box.

4. Run the Panel Edit command. The Panel Edit dialog box will open.

DM Electrical->  Panel Edit

5. Select SWB from the list to see how the wire sizes have changed.

Use Customization in Other Projects

There are two ways you can use your customization in future projects:

1. Use the customization commands in a project template file. Any projects created using the template will use
your customization.

2. Use the Export and Import commands:

a. Use the customization commands in a project.

b. Run the Customization Export command. The Save As dialog box will open.

DM Electrical->  Customization->Export

c. Enter a filename and save the .dmc file.
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d. On your next project, run the Customization Import command and open the .dmc file to load your
customization.

DM Electrical->  Customization->Import
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Creating a One-Line Diagram
The tutorials in this section teach you how to draft a one-line diagram in AutoCAD based upon your Revit model.

If you have Design Master Electrical for AutoCAD installed, the commands used in this section correspond to
the commands located in the One-Line Diagram section of the DM Electrical menus. The icons for the
commands are the same.

Exporting to AutoCAD
This tutorial teaches you how to export your Revit model to AutoCAD.

Export the Model from Revit

1. In Revit, run the Export One-Line command. The Select database to export to dialog box will open.

DM Electrical->  Export One-Line

The first time you run this command, the Export One-Line Riser Diagram dialog box will open. This dialog
box explains the relationship between the one-line diagram in AutoCAD and your Revit model; it also
provides helpful links. You can check the box to prevent this dialog box from opening again. Press the 
OK button to close the dialog box and open the Select database to export to dialog box.

2. Select the dm_elec.dm file you created in the Starting a New Project section and press the Open button.

The information in the Revit model will be exported to the database. This process takes a moment.

Import the Model into AutoCAD

If you are using Design Master Electrical RT in AutoCAD, you do not need to do anything to import the
information. The first time you run a command on the drawing, the information will be imported automatically.

If you have Design Master Electrical for AutoCAD installed instead of the Electrical RT add-in, you must import
the information manually using the RT: Import from Revit command in AutoCAD.

Ribbon: DM Electrical->One-Line Diagram->  RT: Import from Revit

Pulldown Menu: DM Electrical->One-Line Diagram->RT: Import from Revit

You will only need to run this command once for the project.

Inserting Distribution Equipment
This tutorial teaches you how to insert distribution equipment in your one-line diagram.

Open drawing E-0.1.

Insert Distribution Equipment One Piece at a Time
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1. Run the Insert command. The Insert Distribution Equipment dialog box will open.

Ribbon: DM Electrical RT->Distribution Equipment->  Insert

Pulldown Menu: DM Electrical RT->Distribution Equipment->Insert Distribution
Equipment

2. Set Tree to T-SVC.

3. Set Block  to Transformer with Labels, One-Line, with Box.

4. Press the OK button.

5. Follow the prompts at the command line to insert the transformer on the drawing.

6. Run the Insert command. The Insert Distribution Equipment dialog box will open.

Ribbon: DM Electrical RT->Distribution Equipment->  Insert

Pulldown Menu: DM Electrical RT->Distribution Equipment->Insert Distribution
Equipment

7. Set Tree to SWB.

8. Set Block  to <Custom Panel Box with Bus>.

9. Press the OK button.

10.Follow the prompts at the command line to insert the switchboard on the drawing.
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Generate Multiple Pieces of Distribution Equipment

1. Run the Generate One-Line command.

Ribbon: DM Electrical RT->One-Line Diagram->  Generate One-Line

Pulldown Menu: DM Electrical RT->Generate->Generate One-Line

2. Set Tree to T-SVC.

3. Press the OK button.

The remaining devices will be inserted automatically for you.



20

Moving Distribution Equipment and
Feeders

This tutorial teaches you how to move distribution equipment and feeders in your one-line diagram.

Move Distribution Equipment

1. Run the AutoCAD MOVE command.

2. Select panels LP-2, LP-2B, and MP-2B and move them to a new location.

The feeders will follow the panels when they are moved.
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Move Feeder

1. Select the feeder between switchboard SWB and panel MDP-2.

2. Use the grips to move the portion of the feeder connected to SWB.

Adding Labels
This tutorial teaches you how to insert labels in your one-line diagram.

Insert Labels

1. Run the Insert / Modify command.
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Ribbon: DM Electrical RT->Labels->  Insert / Modify

Pulldown Menu: DM Electrical RT->Labels->Insert and Modify Labels

2. Select switchboard SWB on the drawing. The Insert and Modify Labels dialog box will open.

3. In the Description row, set Prefix to SWITCHBOARD. Include a space after SWITCHBOARD so that there is
a space between the label and the panel name.

4. In the Volts row, check the toggle.

5. In the Fault @ Device (A) row, set Prefix to FAULT=.

6. Press the OK button.

7. Specify the insertion point for the switchboard name label.

8. Press ENTER to place the volts label below the switchboard name label.

9. Specify the insertion point for the fault label.

Move Labels

1. Select switchboard SWB.

2. Use the grip on the top left of the fault label to move its location.

3. Use the grips on the right side of the switchboard name and volts label to reduce the size so that the labels
wrap.
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Adding Circuit Breakers
This tutorial teaches you how to insert circuit breakers on your feeders in your one-line diagram.

Add Circuit Breakers

1. Run the Change Graphics command.

Ribbon: DM Electrical RT->Change->  Change Graphics

Pulldown Menu: DM Electrical RT->Change->Change Graphics

2. Select the feeder between switchboard SWB and panel MDP-2. The Change Feeder Blocks dialog box will
open.

3. Set OCP Block  to Circuit Breaker.

4. Press the OK button.

The circuit breaker will be inserted on the drawing.

Updating the One-Line Diagram
This tutorial teaches you how to make changes to your one-line diagram.

Open the Sample Systems Project in Revit.

Change the Distribution Equipment

1. In Revit, run the Panel Edit command. The Panel Edit dialog box will open.

DM Electrical->  Panel Edit
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2. Select transformer TP-1A and set Transformer kVA to 150.

3. Select panel PP-1A and set Main / Bus Amps to 150.

4. Press the Exit button to close the dialog box.

Update the One-Line Diagram to Match

1. In Revit, run the Export One-Line command. The Design Master Electrical RT dialog box will open.

DM Electrical->  Export One-Line

2. Select Calculate and Export.

3. In AutoCAD, open drawing E-0.1 and run the Update command.

Ribbon: DM Electrical RT->One-Line Diagram->  Update

Pulldown Menu: DM Electrical RT->Update One-Line Diagram

The labels on transformer TP-1A, panel PP-1A, and their respective feeders will update to match the changes that
were made.

More Information about One-Line
Diagrams

The previous tutorials cover the basics of using one-line diagrams. There are many features that were not
covered.

Watch the video overview of the one-line diagram or visit the How to Use One-Line Diagrams article in the
knowledge base to learn more.

http://www.designmaster.biz/support/blog/2018/10/one-line-diagram-overview/
http://www.designmaster.biz/support/blog/2015/11/one-line-diagrams/
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Where to Learn More
These tutorials cover the basics of Design Master Electrical RT. They do not cover all of the features and
functionality you might use on a project. Here are a few ways you can learn more about the software.

Visit the Knowledge Base

The Knowledge Base on our website features in-depth articles covering more features of Design Master Electrical
RT.

Send Us Your Project

For specific questions, sending us a copy of the project is usually the fastest way to get help.

Use the DM Electrical RT->  Help->Send Project command in Revit or AutoCAD to send us a copy
of your project.

Running the Send Project command in Revit will open your browser to http://www.designmaster.biz/send/. Fill
out the form and attach your project.

Running the Send Project command in AutoCAD will send the drawing and database to us along with your
question. Not all networks allow our command to send the project to us. If that is the case, it will save a file to
your desktop with your project in it. You need to manually send that file to support@designmaster.biz.

Once we receive your project, we will take a look at it and get back to you with an answer.

Our official support hours are Monday through Friday, 9am to 5pm Eastern time.

Limited support is available evenings and weekends if you send a project or an email.

Call or Chat With Us

You can call us for support at 866-516-9497 x2 or contact us via live chat.

Our official support hours are Monday through Friday, 9am to 5pm Eastern time.

Phone support is only available during our official support hours.

For evening and weekend support, send us a project or an email.

Attend Online Training

We offer online training for Design Master Electrical RT. Visit the Online Training page on our website for
recordings of previous trainings and the current training schedule.

Visit the User Manual

The User Manual on our website contains information about all of the commands in Design Master Electrical RT.

http://www.designmaster.biz/support/blog/
http://www.designmaster.biz/send/
mailto:support@designmaster.biz
http://www.designmaster.biz/chat/
http://www.designmaster.biz/support/online-training.html
http://www.designmaster.biz/docs/elecrt/index.html
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